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Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXA", where “XXXXX” is the document number and “A” is the revision level of the
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help.
Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
MCP16301 High Voltage Buck-Boost Demo Board. ltems discussed in this chapter
include:

* Document Layout

» Conventions Used in this Guide

* Recommended Reading

» The Microchip Web Site

» Customer Support

* Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MCP16301 High Voltage Buck-Boost Demo
Board. The manual layout is as follows:

» Chapter 1. “Product Overview” — Important information about the MCP16301
High Voltage Buck-Boost Demo Board.

» Chapter 2. “Installation and Operation” — Includes instructions on how to get
started with the MCP16301 High Voltage Buck-Boost Demo Board and a
description of the user’s guide.

* Appendix A. “Schematic and Layouts” — Shows the schematic and layout
diagrams for the MCP 16301 High Voltage Buck-Boost Demo Board.

» Appendix B. “Bill of Materials” — Lists the parts used to build the MCP16301
High Voltage Buck-Boost Demo Board.

© 2012 Microchip Technology Inc. DS52020A-page 5
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:
DOCUMENTATION CONVENTIONS

Description

Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User'’s Guide

Emphasized text

...Is the only compiler...

Initial caps A window the Output window
A dialog the Settings dialog
A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”
dialog
Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, Ris the radix and nis a
digit.

4'b0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl8\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants OxFF, ‘A’

Italic Courier New

A variable argument

file.o, where file can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file
[options]

Curly brackets and pipe
character: {| }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]|1}

Ellipses...

Replaces repeated text

var _name [,
var _nane. . .|

Represents code supplied by
user

void main (void)
{
}

DS52020A-page 6
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RECOMMENDED READING

This user's guide describes how to use the MCP16301 High Voltage Buck-Boost Demo
Board. Other useful documents are listed below. The following Microchip documents
are available and recommended as supplemental reference resources.

« MCP16301 Data Sheet — “High Voltage Input Integrated Switch Step-Down
Regulator” (DS25004)

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

* Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

» General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

* Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

+ Distributor or Representative

* Local Sales Office

* Field Application Engineer (FAE)
 Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com.

DOCUMENT REVISION HISTORY
Revision A (January 2012)

« Initial Release of this Document.

© 2012 Microchip Technology Inc. DS52020A-page 7
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MICROCHIP USER’S GUIDE
Chapter 1. Product Overview

1.1 INTRODUCTION

This chapter provides an overview of the MCP16301 High Voltage Buck-Boost Demo
Board and covers the following topics:

*+ MCP16301 Short Overview
* What is the MCP16301 High Voltage Buck-Boost Demo Board?
+ MCP16301 High Voltage Buck-Boost Demo Board Kit Contents

1.2 MCP16301 SHORT OVERVIEW

The MCP16301 is a highly integrated, high-efficiency, fixed frequency, step-down
DC-DC converter in a popular 6-pin SOT23 package that operates from input voltage
sources up to 30V. Integrated features include a high-side switch, fixed-frequency
peak-current mode control, internal compensation, peak current limit and over-temper-
ature protection. Minimal external components are necessary to develop a complete
step-down DC-DC converter power supply.

High converter efficiency is achieved by integrating the current limited, low resistance,
high-speed N-Channel MOSFET and associated drive circuitry. High switching
frequency minimizes the size of external filtering components resulting in a small
solution size.

The MCP16301 can supply 600 mA of continuous current while regulating the output
voltage from 2.0V to 15V. An integrated high performance, peak-current mode
architecture keeps the output voltage tightly regulated, even during input voltage steps
and output current transient conditions that are common in power systems.

With the addition of a MOSFET driver, an external N-channel MOSFET and a second
Schottky diode, the MCP16301 can function properly as a buck-boost converter.

The capabilities of this buck-boost converter are an input voltage range of 5V to 30V,
an output voltage range of 2V to 30V and an output current dependent upon Vy. The
typical maximum output current for a 12V output can be seen in Figure 2-1: “Typical
Maximum Output Current vs. Input Voltage”.

© 2012 Microchip Technology Inc. DS52020A-page 9
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FIGURE 1-1: Typical MCP16301 Buck-Boost Application.

1.3 WHAT IS THE MCP16301 HIGH VOLTAGE BUCK-BOOST DEMO BOARD?

The MCP16301 High Voltage Buck-Boost Demo Board is designed to operate from a
5V to 30V input and regulate the output to 12V. Test points for input power and load are
provided to demonstrate the capability of the demo board over the entire range. The
MCP16301 High Voltage Buck-Boost Demo Board was designed using small
surface-mount components to show application size for a high voltage buck-boost
design.

1.4 MCP16301 HIGH VOLTAGE BUCK-BOOST DEMO BOARD KIT CONTENTS

This MCP16301 High Voltage Buck-Boost Demo Board kit includes the following items:

+ MCP16301 High Voltage Buck-Boost Demo Board, 102-00399
* Important Information Sheet

DS52020A-page 10 © 2012 Microchip Technology Inc.
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Chapter 2. Installation and Operation

2.1 INTRODUCTION

2.1.1 MCP16301 Features

The MCP16301 device has been developed to provide high input voltage applications
with a precise regulated rail while operating at high efficiency.

The key features of the MCP16301 include:
» Up to 96% Typical Efficiency

* Input Voltage Range: 4.0V to 30V

» Output Voltage Range: 2.0V to 15V

* 2% Output Voltage Accuracy

* Integrated N-Channel Switch: 460 mQ
* 500 kHz Fixed Frequency

+ Adjustable Output Voltage

* Low Device Shutdown Current

» Peak Current Mode Control

* Internal Compensation

+ Stable with Ceramic Capacitors

* Internal Soft-Start

» Cycle-by-Cycle Peak Current Limit

» Under Voltage Lockout (UVLO): 3.5V
» Overtemperature Protection

* Available Package: SOT23-6

A high performance peak-current mode control system is used to deliver fast response
to sudden line and load changes.

2111 MCP16301 HIGH VOLTAGE BUCK-BOOST DEMO BOARD FEATURES

The MCP16301 High Voltage Buck-Boost Demo Board is developed to demonstrate
how the MCP16301 device operates as a Buck-Boost topology over a wide input
voltage and load range. Test points are provided for input and output, allowing the
demo board to be connected directly to a system.

The MCP1402 Tiny 500 mA, High-Speed Power MOSFET Driver is utilized to drive the
external N-Channel MOSFET allowing the MCP16301 to buck and boost. The
maximum output current of the MCP16301 High Voltage Buck-Boost Demo Board is
dependent upon input voltage and inductance. The MCP 16301 will regulate the output
to 12V until the peak current in the inductor reaches the maximum-rated value.
Figure 2-1 shows the typical maximum output current vs. input voltage for an output
voltage of 12V.

A copper via connected to the EN input can be used to turn the MCP16301 on and off.
Turning the device on (EN>1.4V) when the undervoltage lockout threshold is met
(V\N>3.5V), will enable the device.

© 2012 Microchip Technology Inc. DS52020A-page 11
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FIGURE 2-1: Typical Maximum Output Current vs. Input Voltage

2.2 GETTING STARTED

The MCP16301 High Voltage Buck-Boost Demo Board is fully assembled and tested
to evaluate and demonstrate the MCP 16301 operation in a buck-boost topology.

2.2.1 Power Input and Output Connection

2211 POWERING THE MCP16301 HIGH VOLTAGE BUCK-BOOST DEMO

BOARD

The MCP16301 High Voltage Buck-Boost Demo Board is fully assembled, tested and
ready to begin evaluation. Apply positive input voltage to the V\ terminal and its return
to the GND terminal. The maximum input voltage should not exceed 30V. An electronic
load or resistive load can be used for evaluation or the intended system load can be
connected. Electronic loads attempt to sink current at OV during startup, a resistive load
or constant resistance is recommended for startup evaluation. Connect the positive
voltage terminal of the load to the V1 terminal on the demo board and connect the
negative or return side of the load to the GND terminal.

2212 BOARD TESTING

To test the board, follow the next steps:
1. Apply input voltage.

2. Aninternal pull up resistor is connected from V\ to the EN input of the
MCP16301, once the input voltage is greater than 3.5V the device will begin to
switch. Apply greater than 5V to the input for proper operation, a minimum load
is required to regulate the output to 12V. Detailed information is provided in the
MCP16301 data sheet (DS25004) for minimum load requirements for light load
conditions.

3. The measured output voltage should be 12V typical, adjusting the input voltage

and load should not cause the output to vary more than a few mV over the
operating range of the converter.

DS52020A-page 12
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Installation and Operation

2213 HOW THE MCP16301 HIGH SIDE DRIVE BOOST CIRCUIT OPERATES

The MCP16301 integrates a low resistance N-Channel MOSFET. A high side or
floating supply is needed to drive the gate of the N-Channel MOSFET above the input
voltage to turn it on. The demo board uses the output voltage and a 7.5V zener diode
to charge the boost cap while the inductor current flows, clamping the SW node to a
diode drop below ground. Prior to startup, there is no inductor current, so an internal
precharge circuit charges the boost cap up to a minimum threshold. Once charged, the
N-Channel can be turned on, ramping current into the inductor.

The worst case operating conditions, for charging the boost capacitor, occur at
minimum Vy and no load. At minimum V| (5V), there is not enough head room to
precharge the boost cap to a satisfactory value. At no load, the converter is operating
at a minimum or very low duty cycle, putting a small amount of current into the inductor.
When the switch turns off, the inductor current decays very quickly, resulting in a short
time to recharge the boost capacitor.

© 2012 Microchip Technology Inc. DS52020A-page 13
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Appendix A. Schematic and L ayouts

A.1 INTRODUCTION
This appendix contains the following schematics and layouts for the MCP16301 High
Voltage Buck-Boost Demo Board:
» Board — Schematic
» Board — Top Layer
» Board — Top Copper Layer
» Board — Bottom Copper Layer

© 2012 Microchip Technology Inc. DS52020A-page 15
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Schematic and Layouts

A.3 BOARD -TOP LAYER
102—00399 SW
VIN EN Rzﬁ H D-3 o MicrocHIP
R3 MCP16301 High Voltage
Cé D-4- Buck—Boost Demo Board
R4
A.4 BOARD - TOP COPPER
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Appendix B. Bill of Materials

TABLE B-1: BILL OF MATERIALS (BOM)
Qty | Reference Description Manufacturer Part Number
4 BUMPON SQUARE .40X.10 BLACK 3M SJ5007-0-ND
1 - RoHS Compliant Bare PCB, MCP16301 Microchip Technology Inc. | 104-00399
Buck-Boost
2 C1; C2 CAP 4.7uF 50V CERAMIC X7R 1210 10% | Taiyo Yuden Co., Ltd. 587-2673-2-ND
2 C3;C4 CAP CER 10uF 16V X5R 0805 TDK Corporation 445-4115-1-ND
1 C5 CAP 0.1uF 16V CERAMIC X7R 0603 10% | AVX Corporation 478-1239-1-ND
1 C6 Not Installed. Do not populate. - -
1 D1; D2 DIODE SCHOTTKY 40V 1A SMA Diodes Incorporated® B140-FDICT-ND
1 D3 DIODE SWITCH 75V 200MW SOD-323 | Diodes Incorporated 1N4448WS-FDICT-ND
1 D4 DIODE ZENER 7.5V 200MW SOD323 Diodes Incorporated BZT52C7V5S-FDICT-ND
1 L1 MSS1038 47uH Shielded Power Inductor | Coilcraft MSS1038-473ML
1 R1 RES 100K OHM 1/10W 1% 0603 SMD Panasonic-ECG® P100KHCT-ND
1 R2 RES 140K OHM 1/10W 1% 0603 SMD Panasonic-ECG P140KHCT-ND
1 R3 RES 10.0K OHM 1/10W 1% 0603 SMD Panasonic-ECG P10.0KHCT-ND
2 R4; R5 RES 2.21K OHM 1/4W 1% 1206 SMD Panasonic-ECG P2.21KFCT-ND
4 TP1;TP2; |PC TEST POINT TIN SMD Harwin PLC. 952-1478-1-ND
TP3;TP4
1 U1 MCP 16301 High Voltage Input Buck Con- | Microchip Technology Inc. | MCP16301T-I/CHY
verter SOT23
1 u2 MCP 1402 Tiny 500 mA, High-Speed Microchip Technology Inc. | MCP1402T-E/OT
Power MOSFET Driver
1 u3 MOSFET N-CH 30V 2.7A SSOT3 Fairchild Semiconductor® | FDN359BNCT-ND

Note 1:

The components listed in this Bill of Materials are representative of the PCB assembly. The

released BOM used in manufacturing uses all RoHS-compliant components.

© 2012 Microchip Technology Inc.
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